Abstract
This document describes configuration during and after database installation when IMC is used with Microsoft SQL Server. This document is applicable to the SQL Server 2014 Evaluation edition and can be slightly different from other editions of SQL Server 2014. This document is intended for use by network engineers or system administrators responsible for installing network software and components.
SQL Server 2014 in IMC

Before installing IMC, install the SQL Server on a database server used for storing IMC data, or install it on the server on which you plan to install IMC.

This document provides installation and configuration procedures for Microsoft SQL Server 2014. For more information about using the database for IMC, see the HPE IMC deployment guides.

If you plan to install the database on a separate database server, follow these guidelines:

- Before installing IMC, install a SQL Server client on the same server as IMC. The client version must match the version of the SQL Server the database.
- Before installing IMC, create a data file folder for storing IMC data on the database server. You must specify the local path to the folder during the deployment of IMC components, as shown in Figure 1.

Figure 1 Database Configuration dialog box during IMC installation

![Database Configuration dialog box](image)

**NOTE:**
Use Microsoft SQL Server licensed installation software. Localized software or other unauthorized editions might cause a failure in database installation and operation.
Preparing for installation

Before installing SQL Server 2014 and the SQL Server client, turn off the Windows firewall on the SQL Server host to open TCP port 1443.

To turn off the Windows firewall:

1. Select Start > Control Panel > System and Security > Windows Firewall. The Windows Firewall page appears, as shown in Figure 2.

   **Figure 2 Windows Firewall page**

   ![Windows Firewall page]

2. Select Turn Windows Firewall on or off. The Customize Settings page appears, as shown in Figure 3.
3. Select **Turn off Windows Firewall** (not recommended) for both Private network settings and Public network settings, and then click **OK**.

The **Windows Firewall** page displays the firewall status.
Figure 4 Disabling Windows firewall
Installing SQL Server 2014

1. Run the installation program.
   The SQL Server Installation Center wizard appears, as shown in Figure 5.

   **Figure 5 SQL Server Installation Center wizard**

2. Select **Installation** in the navigation tree, and then select **New SQL Server stand-alone installation or add features to an existing installation**.
   The **Product Key** page appears, as shown in Figure 6.
3. Enter the product key and then click **Next**.

The **License Terms** page appears, as shown in **Figure 7**.
4. Select **I accept the license terms** and click **Next**.
   The **Global Rules** page appears, as shown in **Figure 8**.
When the check has been passed, the **Microsoft Update** page appears, as shown in Figure 9.

Figure 8 Global Rules page

![Global Rules page](image)

Figure 9 Microsoft Update page

![Microsoft Update page](image)
5. Click **Next**.
   The **Product Updates** page appears.

6. Click **Next** if no update is required.
   The **Install Setup Files** page appears, as shown in **Figure 10**.

**Figure 10 Install Setup Files page**

When system preparations are complete, the **Install Rules** page appears, as shown in **Figure 11**.
When the rules check is complete, the **Setup Role** page appears, as shown in **Figure 12**.

**Figure 12 Setup Role page**
7. Select **SQL Server Feature Installation** and click **Next**.

The Feature Selection page appears, as shown in **Figure 13**.

**Figure 13 Feature Selection page**

8. Select the features to install, and then specify the **Instance root directory**, **Shared feature directory**, and **Shared feature directory (x86)**.

The default directory settings are **C:\Program Files\Microsoft SQL Server**, **C:\Program Files\Microsoft SQL Server**, and **C:\Program Files(x86)\Microsoft SQL Server**. Specify a disk with sufficient space for the directories. This example uses disk drive **D**.

9. Click **Next**.

The Feature Rules page appears, as shown in **Figure 14**.
When the feature rules check is complete, the **Instance Configuration** page appears, as shown in Figure 15.
10. Install a default instance or a named instance of the SQL Server.
   - To install the default instance, select **Default instance** and specify an instance ID. The default instance ID is **MSSQLSERVER**.
   - To install a name instance, select **Named Instance** and specify an instance ID. You are required to provide the instance name during IMC installation.
     In this example, select **Default instance** and use the default instance ID **MSSQLSERVER**.

11. Click **Next**.
   The **Server Configuration** page appears, as shown in **Figure 16**.
12. Use the default settings on the **Service Accounts** tab.

13. Click the **Collation** tab, as shown in Figure 17.
14. Use the default collation settings or modify the settings to meet specific language requirements, and then click **Next**.

The **Database Engine Configuration** page appears, as shown in Figure 18.
15. Under **Authentication Mode**, select **Mixed Mode**, enter the password for user **sa**, and add a SQL Server administrator, as shown in Figure 19.

- SQL Server 2014 has password complexity requirements. For more information, see the SQL Server 2014 online help.
- For IMC to identify the **sa** logon password during installation, make sure the password does not contain any of the following characters:
  - Left angle bracket (<)
  - Right angle bracket (>)
  - Vertical bar (|)
  - Tab (\t)
- If the password of user **sa** must contain any of the previous characters, create a superuser with **sa** user privileges before the IMC installation. Make sure the password of the superuser does not contain any of the previous characters. For information about creating a database superuser, see "Creating a superuser."
16. Use the default settings on the **Data Directories** tab, as shown in Figure 20.
17. Use the default settings on the **FILESTREAM** tab, as shown in Figure 21.
18. Click **Next**.

The **Feature Configuration Rules** page appears, as shown in Figure 22.
When the features check has been passed, the **Ready to Install** page appears, as shown in **Figure 23**.
19. Click **Install**.

The **Installation Progress** page appears, as shown in **Figure 24**.
When the installation is complete, the **Complete** page appears, as shown in Figure 25.
20. Click **Close**.
21. Restart the operating system.
Registering the SQL Server license

The SQL Server supports the following license registration modes:

- **Per User licensing**—Used to register the SQL Server 2014 Developer and Parallel Data Warehouse.

- **Per Processor licensing**—Used to register the SQL Server Developer and Parallel Data Warehouse. The number of Per Processor licenses is determined by the number of processors on a SQL server. You must buy a Per Processor license for each processor on a server on which the SQL server component is installed. With Per Processor licensing, the number of SQL servers and IMC servers is not relevant. Per Processor licensing is applicable to networks that contain several SQL servers and IMC servers. Figure 26 displays an example of Per Processor licensing for SQL Server 2008 R2.

  **Figure 26 Per Processor licensing**

  ![Per Processor licensing diagram]

  **NOTE:**
  The number of Per Processor licenses is not determined by the number of kernels in a processor.

- **Server/CAL licensing**—The number of Server/CAL licenses is determined by the number of SQL servers and IMC servers. You must buy a server license for each SQL server and a CAL license for each IMC server. Server/CAL licensing is applicable to networks that contain few SQL servers and IMC servers. Figure 27 displays an example of Per Processor licensing for SQL Server 2008 R2.
Before choosing a license registration mode, determine the IMC deployment environment:

- If IMC is deployed in centralized mode, buy a CAL license for the IMC server only.
- If IMC is deployed in distributed mode, buy a CAL license for each IMC server that must access the SQL Server.

For more information about SQL Server license registration, see the related Microsoft documentation.

**NOTE:**
The license registration modes apply to the Standard and Enterprise editions of SQL Server 2008/2008 R2/2012/2014. You do not need to buy a license for other editions such as the Express edition.
Installing the SQL Server client

Installation procedure

1. Run the SQL Server 2014 installation program.
2. In the Feature Selection page, select the features Management Tools - Basic and SQL Client Connectivity SDK, as shown in Figure 28.
   For information about displaying the Feature Selection page, see "Installing SQL Server 2014."

   **Figure 28 Feature Selection page**

   ![Feature Selection page](image)

3. Click Next.
   The Feature Rules page appears, as shown in Figure 29.
When the feature rules check is complete, the **Feature Configuration Rules** page appears, as shown in Figure 30.
When the feature configuration rules check is complete, the Ready to Install page appears, as shown in Figure 31.
4. Click **Install**.

The **Installation Progress** page appears, as shown in Figure 32.
When the installation is complete, the **Complete** page appears, as shown in Figure 33.

**Figure 33 Complete page**
5. Click Close.
6. Restart the operating system.

Testing connectivity

To test the connectivity between the client and the SQL Server database:
1. Select Run from the Start menu, and then enter cmd in the Run dialog box.
2. In the CMD window, enter one of the following commands:
   - For the default instance:
     \osql -S 192.168.20.110 -U sa -P iMC123456
   - For a named instance:
     \osql -S 192.168.20.110\instancename -U sa -P iMC123456

In these commands, 192.168.20.110 is the IP address of the SQL Server database, sa and iMC123456 are the username and password of the default superuser, and instancename represents the named instance.

If the SQL command prompt appears, you have connected to the SQL Server database, as shown in Figure 34.

Figure 34 Testing connectivity
Configuring SQL Server 2014

The following information describes the procedures to configure the SQL Server database.

Configuring TCP/IP properties

1. Select Start > SQL Server 2014 Configuration Manager. The SQL Server Configuration Manager appears.
2. From the navigation tree, select SQL Server Network Configuration > Protocols for MSSQLSERVER, as shown in Figure 35.

Figure 35 SQL Server Configuration Manager

3. Right-click TCP/IP and select Properties from the shortcut menu. The TCP/IP Properties dialog box appears, as shown in Figure 36.
4. On the **Protocol** tab, make sure **Yes** is selected for **Listen All**.
5. Click the **IP Addresses** tab, select **Yes** for the **Enabled** option of each IP address, and set **TCP Port** to **1433**, as shown in Figure 37.
6. Click **OK**.

   The system displays a message that indicates the database service must be restarted to validate the configuration.

7. Click **OK**.

8. Restart the SQL Server service. For more information, see "Restarting the SQL Server service."

**NOTE:**

- When **Yes** is selected for **Listen All** on the **Protocol** tab, the SQL Server automatically updates IP address settings after an IP address is changed. If you selected **No**, you must manually update the IP addresses.
- You can enable the **Named Pipes** property in the same way.
- In distributed deployment, make sure you configure all database servers to use the same listening port.

---

### Modifying the maximum server memory for the SQL Server

To ensure the optimum performance, the SQL Server is preemptive and uses a default maximum server memory of 2147483647 MB. When IMC and the SQL Server are installed on the same server, you must reduce the maximum server memory for the SQL Server. As a best practice, set the maximum server memory to half the server's physical memory.
To modify the maximum server memory for the SQL Server:

1. Select **Start > SQL Server 2014 Management Studio**.

2. In the **Connect to Server** dialog box, configure the following parameters, as shown in **Figure 38**:
   a. Select **SQL Server Authentication** for the **Authentication** field.
   b. Enter **sa** in the **Login** field.
   c. Enter the password in the **Password** field.

   **Figure 38 Database login dialog box**

3. Click **Connect**.
   The **Microsoft SQL Server Management Studio (Administrator)** page appears, as shown in **Figure 39**.
4. Right-click the server name and select **Properties** from the shortcut menu. The **Server Properties** page appears.

5. Select **Memory** in the navigation tree, set the maximum server memory to half the server's physical memory, and click **OK**. This example uses 2048 MB.
6. Restart the operating system to validate the modification.

Starting the SQL Server Browser service

To enable IMC to connect to a named instance of SQL Server 2014, you must start the SQL Server Browser service after the SQL Server installation is complete.

To start the SQL Server Browser service:

1. Select **Start > SQL Server 2014 Configuration Manager**.
2. Select **SQL Server Services** from the navigation tree, right-click **SQL Server Browser** on the main pane, and then select **Properties** from the shortcut menu.
3. Click the **Service** tab and then select **Automatic** for **Start Mode**.

4. Click **OK**.
The dialog box closes.

5. Right-click SQL Server Browser, and then select Start from the shortcut menu.

Figure 43 Starting the SQL Server Browser service

---

Changing the SQL Server service startup account

When you specify a superuser for IMC to use a remote SQL Server database, the user must have write permissions to all the disks on the database server. To ensure that, you must configure the SQL Server service to start up using the built-in local system account.

To configure the SQL Server service to start up using the built-in local system account:

1. Select Start > All Programs > Microsoft SQL Server 2014 > Configuration Tools > SQL Server Configuration Manager.

2. From the navigation tree, select SQL Server Services.

The main pane displays the services installed by SQL Server, as shown in Figure 44.

Figure 44 Services installed by SQL Server
3. Right-click **SQL Server (MSSQLSERVER)**, and then select **Properties** from the shortcut menu.

4. Click the **Log On** tab.

   **Figure 45 Log On tab**

5. Make sure **Local System** is selected for the **Built-in account** list.

6. Click **OK**.

7. Restart the SQL Server service to validate the configuration.

### Restarting the SQL Server service

1. Select **Start > All Programs > Microsoft SQL Server 2014 > Configuration Tools > SQL Server Configuration Manager**.

2. From the navigation tree, select **SQL Server Services**.

3. Right-click **SQL Server (MSSQLSERVER)** on the main pane.

4. Click the **Restart service** icon on the toolbar, as shown in **Figure 46**.
Creating a superuser

The SQL Server database has a default superuser named sa. To specify another user for database access during IMC installation, first create a login user and grant administrator privilege to the user on the SQL Server.

To create a superuser:

   The database login dialog box appears, as shown in Figure 47.

   **Figure 47 Login dialog box**

2. Select SQL Server Authentication for Authentication, select a login username, enter the password, and then click Connect.
The Microsoft SQL Server Management Studio page appears, as shown in Figure 48.

Figure 48 Microsoft SQL Server Management Studio page

3. Expand the Security node in the navigation tree, right-click Logins, and select New Login from the shortcut menu.

The Login - New page appears, as shown in Figure 49.
4. On the **General** page, enter the login name, click **SQL Server authentication**, enter the password, and then clear **User must change password at next login**. This example uses **imctest** as the login name.

For IMC to correctly identify the password, make sure the password does not contain any of the following characters:

- Left angle bracket (<)
- Right angle bracket (>)
- Vertical bar (|)
- Tab (\t)

5. From the navigation tree, select **Server Roles**.
6. Select **public** and **sysadmin** and click **OK**.

   The user is granted database administrator privileges and appears under the **Security > Logins** node in the navigation tree of **Microsoft SQL Server Management Studio**, as shown in **Figure 51**.
Figure 51 Viewing the new user
Uninstalling SQL Server 2014

1. Select Start > Control Panel > Uninstall or Change a program > Uninstall/Change.
2. Select Microsoft SQL Server 2014 (64-bit), and then click Uninstall.
3. Follow the same procedure to uninstall other programs shown in Figure 52.

Figure 52 Uninstalling SQL Server 2014
FAQ

The default instance of the database is used by another application. How do I install the database using a named instance?

The installation procedure for using a named instance is similar to the installation procedure for using the default instance. The following information describes only the differences.

1. After the Setup Support Rules check is complete, click **Next**.
   The Installation Type page appears, as shown in **Figure 53**.

   **Figure 53 Installation Type page**

2. Select **Perform a new installation of SQL Server 2014** and then click **Next**.
3. Enter the product key, accept the license terms, and then select the setup role.
   The Feature Selection page appears.
4. Select the features shown in Figure 54, and then click Next.
When the rule check is complete, the Instance Configuration page appears, as shown in Figure 55.
5. Select **Named instance**, enter an instance name, and then click **Next**.
The **Server Configuration** page appears.
6. Configure the account names for the SQL Server services shown in Figure 56.
7. Click Next.
   The Database Engine Configuration page appears, as shown in Figure 57.
8. Under **Authentication Mode**, select **Mixed Mode**, and then enter the password of user **sa**. Make sure the password does not contain any of the following characters:
   - Left angle bracket (<)
   - Right angle bracket (>)
   - Vertical bar (|)
   - Tab (\)

Use the default settings on the **Data Directories** and **FILESTREAM** tabs. The next setup steps are the same as those for the default instance.

**Does changing the computer name affect the database? How do I restore the database?**

Changing the name of the computer running the SQL Server might cause database operations to fail. Perform the following steps to update the computer name saved in the database. In this example, the old computer name is **SERVER_1**, and the new computer name is **SERVER_2**.

1. Open the **CMD** window and execute the following scripts (the login username is **sa**, and the password is **iMCpass**):
   ```
   osql -Usa -PIMCpass
   select @SERVERNAME
   go
   ```
   The old computer name **SERVER_1** is displayed in the interface.

2. Execute the following commands to modify the computer name saved in the database:
   ```
   sp_dropper @server='SERVER_1', @droplogins=NULL
   go
   sp_addserver @server='SERVER_2', @local='local', @duplicate_ok='duplicate_OK'
   go
   ```
The old computer name SERVER_1 is deleted, and the new computer name SERVER_2 is added.

3. Restart the SQL Server service in the Windows Service Manager to restore the database.

**During IMC installation, the following message is displayed: MS SQLServer is not Installed Correctly, MSSOLSERVER Service Does not Exist. How do I resolve the issue?**

The MSSQLSERVER string is the default instance name of the Microsoft SQL Server. This message indicates that you have selected the default instance, but the instance does not exist. If you do not select the default instance, but you specify the instance name ABC, MSSQL$ABC is displayed.

To resolve the issue, check the default instance name in the SQL Server Configuration Manager, and specify the correct instance name during IMC installation.

**During IMC installation, the following message is displayed: Database Service MSSQLSERVER Is not Configured to Be Started with Local System. How do I resolve the issue?**

To create the database file for IMC, the MSSQLSERVER service must start with the local system and must have write privileges to any local disk. Otherwise, IMC cannot be installed.

For the configuration procedure, see "Changing the SQL Server service startup account."

**During IMC installation, the following message is displayed: The ADO 1.5 Component Is not Found in Current System. How do I resolve the issue?**

IMC uses ADO 1.5 to connect the database. ADO 1.5 is provided by the operating system.

This message indicates that ADO 1.5 is corrupted. To resolve the issue, reinstall ADO on the host.

**During IMC installation, the following message is displayed: Provider Cannot Be Found. How do I resolve the issue?**

This message indicates that MDAC is not installed on the server, or that the MDAC installation is corrupted. MDAC corruption typically occurs when application programs attempt to install a partial version of MDAC.

To resolve the issue, download the installation program mdac_typ.exe from the Microsoft website, and then reinstall MDAC. If the MDAC installation fails, perform the following steps:

1. In Windows Explorer, open the C:\WINDOWS\inf folder. (This folder might be hidden.)
2. Right-click the mdac.inf file and select Install.

   You can select files from the Service Pack CD or the current operating system.

      o To select files from the Service Pack CD, locate the i386 directory on the CD drive. For example, if the CD drive is D, select the directory D:\i386.

      o To select files from the current operating system, click Browse, select a file, and click Retry.

   The following files must be located during installation:
      - File name: adcjavas.inc
        Location: C:\Program Files\Common Files\System\msadc
      - File name: adojavas.inc
        Location: C:\Program Files\Common Files\System\ado
      - File name: msdadc.dll
        Location: C:\Program Files\Common Files\System\ole db
      - File name: dao360.dll
        Location: C:\Program Files\Common Files\Microsoft shared\dao
      - File name: handler.reg
        Location: C:\Program Files\Common Files\System\msadc
3. When the installation is complete, reboot the operating system.

**NOTE:**
The MDAC installation is successful if no error message is displayed.

4. If the problem persists, use the MDAC Component Checker to identify MDAC installation problems:
   a. Download the MDAC Component Checker cc_pkg.exe from the Microsoft website.
   b. Decompress the file to the C:\ComponentChecker directory.
   c. In the **Component Checker** dialog box, select the first option, and then click **OK**

   ![Component Checker dialog box](image)

   After performing the analysis, mismatch information is displayed under **File Details**. This information indicates potential problems with the MDAC installation.

   ![Mismatch information under File Details](image)
d. Click **MISMATCH** and view the files in the main pane. These file versions are different from the MDAC version. The **Mismatch Field** column displays expected file versions. The **File Version** column displays actual file versions.

5. If the version mismatch information cannot be resolved through MDAC installation, copy files to the corresponding directories.
   a. Locate the `mdacxpak.cab` file from the decompressed file `mdac_typ.exe`. Use WinZip to decompress the `mdacxpak.cab` file, which contains most of the important MDAC files.
   b. Copy the decompressed files to the corresponding paths displayed in **MISMATCH**.
   c. Reboot the operating system.

6. If you still cannot resolve the issue, reinstall the operating system and databases, or contact Hewlett Packard Enterprise Support.

During IMC installation, the following message is displayed: "Failed to run bcp.exe, Database tools not installed or Windows not restarted after MS SQL Server installed. How do I resolve the issue?"

For IMC to access a remote database server using the `bcp.exe` tool, make sure the **Client Tools Connectivity** feature is installed on the IMC server.

To install the feature:
1. Run the SQL Server 2014 installation program.
2. Select **Client Tools Connectivity** on the **Feature Selection** page, as shown in Figure 60.

![Figure 60 Feature Selection page](image)
3. Restart Windows to make the client software bcp.exe take effect after the Client Tools Connectivity feature is installed.

How do I update database passwords for IMC?

After the database password of an IMC component is changed using the database management tool, execute pwdmgr.bat to update the password in the file server-addr.xml on the IMC server. The file is located in directory \common\conf in the IMC installation path. It stores database passwords of all IMC components in ciphertext.

The following example uses 192.168.20.107 as the IP address of the database. The dbpassword string represents the new database password of the imc_config user. The config_db string represents the database name. The database IP address and name can be retrieved from the file server-addr.xml.

Figure 61 Updating database passwords for IMC

If IMC is deployed in distributed mode, you must update the database password on every IMC server.

Why can't I install SQL Server on a Microsoft Gold Standard server?

To install SQL Server on a Microsoft Gold Standard server, make sure you are a system user with the proper privileges.

Table 1 User privileges

<table>
<thead>
<tr>
<th>Local policy object display name</th>
<th>User privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup files and directories</td>
<td>SeBackupPrivilege</td>
</tr>
<tr>
<td>Debug programs</td>
<td>SeDebugPrivilege</td>
</tr>
<tr>
<td>Manage auditing and security log</td>
<td>SeSecurityPrivilege</td>
</tr>
</tbody>
</table>
# About HPE IMC documents

The following are the documents available for HPE IMC:

<table>
<thead>
<tr>
<th>Documents</th>
<th>Purposes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware specifications and installation</strong></td>
<td></td>
</tr>
<tr>
<td>HP IMC Getting Started Guide</td>
<td>Quickly guides you through the IMC main features and troubleshooting common problems.</td>
</tr>
<tr>
<td>HP IMC Installation Guide</td>
<td>Provides a complete guide to IMC platform and component installation and deployment.</td>
</tr>
<tr>
<td>HP IMC Probe Installation Guide</td>
<td>Provides a complete guide to IMC Probe installation and deployment.</td>
</tr>
<tr>
<td>SQL Server 2008 Installation and Configuration Guide</td>
<td>Guides you through installing SQL Server 2008 for IMC.</td>
</tr>
<tr>
<td>SQL Server 2008 R2 Installation and Configuration Guide</td>
<td>Guides you through installing SQL Server 2008 R2 for IMC.</td>
</tr>
<tr>
<td>SQL Server 2012 Installation and Configuration Guide</td>
<td>Guides you through installing SQL Server 2012 for IMC.</td>
</tr>
<tr>
<td>SQL Server 2014 Installation and Configuration Guide</td>
<td>Guides you through installing SQL Server 2014 for IMC.</td>
</tr>
<tr>
<td>Oracle 11g Installation and Configuration Guide(for Linux)</td>
<td>Guides you through installing Oracle 11g on Linux for IMC.</td>
</tr>
<tr>
<td>Oracle 11g R2 Installation and Configuration Guide(for Linux)</td>
<td>Guides you through installing Oracle 11g R2 on Linux for IMC.</td>
</tr>
<tr>
<td>Oracle 12c Installation and Configuration Guide(for Linux)</td>
<td>Guides you through installing Oracle 12c on Linux for IMC.</td>
</tr>
<tr>
<td>MySQL 5.5 Installation and Configuration Guide (for Linux)</td>
<td>Guides you through installing MySQL 5.5 on Linux for IMC.</td>
</tr>
<tr>
<td>MySQL 5.5 Installation and Configuration Guide (for Windows)</td>
<td>Guides you through installing MySQL 5.5 on Windows for IMC.</td>
</tr>
<tr>
<td>MySQL 5.6 Installation and Configuration Guide (for Linux)</td>
<td>Guides you through installing MySQL 5.6 on Linux for IMC.</td>
</tr>
<tr>
<td>MySQL 5.6 Installation and Configuration Guide (for Windows)</td>
<td>Guides you through installing MySQL 5.6 on Windows for IMC.</td>
</tr>
<tr>
<td>Red Hat Enterprise Linux 6.4 Installation Guide</td>
<td>Guides you through installing Red Hat Enterprise Linux 6.1 for IMC</td>
</tr>
<tr>
<td><strong>Software configuration</strong></td>
<td></td>
</tr>
<tr>
<td>HP IMC Base Platform Administrator Guide</td>
<td>Describes operation procedures on the IMC base platform.</td>
</tr>
<tr>
<td>Online Help</td>
<td>Helps you properly use IMC.</td>
</tr>
<tr>
<td><strong>Operations and maintenance</strong></td>
<td></td>
</tr>
<tr>
<td>Readme</td>
<td>Provides most recent IMC release information.</td>
</tr>
</tbody>
</table>
## Document conventions

This section describes the conventions used in the documentation.

### Port numbering in examples

The port numbers in this document are for illustration only and might be unavailable on your device.

### Command conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boldface</strong></td>
<td><strong>Bold</strong> text represents commands and keywords that you enter literally as shown.</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td><em>Italic</em> text represents arguments that you replace with actual values.</td>
</tr>
<tr>
<td>#</td>
<td>A line that starts with a pound (#) sign is comments.</td>
</tr>
</tbody>
</table>

### GUI conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Boldface</strong></td>
<td>Window names, button names, field names, and menu items are in <strong>Boldface</strong>. For example, the <strong>New User</strong> window appears; click <strong>OK</strong>.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Multi-level menus are separated by angle brackets. For example, <strong>File &gt; Create &gt; Folder</strong>.</td>
</tr>
</tbody>
</table>

### Symbols

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![WARNING!]</td>
<td>An alert that calls attention to important information that if not understood or followed can result in personal injury.</td>
</tr>
<tr>
<td>![CAUTION:]</td>
<td>An alert that calls attention to important information that if not understood or followed can result in data loss, data corruption, or damage to hardware or software.</td>
</tr>
<tr>
<td>![IMPORTANT:]</td>
<td>An alert that calls attention to essential information.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>An alert that contains additional or supplementary information.</td>
</tr>
<tr>
<td>![TIP:]</td>
<td>An alert that provides helpful information.</td>
</tr>
</tbody>
</table>
Support and other resources

Accessing Hewlett Packard Enterprise Support

- For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website: www.hpe.com/assistance
- To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website: www.hpe.com/support/hpesc

Information to collect
- Technical support registration number (if applicable)
- Product name, model or version, and serial number
- Operating system name and version
- Firmware version
- Error messages
- Product-specific reports and logs
- Add-on products or components
- Third-party products or components

Accessing updates

- Some software products provide a mechanism for accessing software updates through the product interface. Review your product documentation to identify the recommended software update method.
- To download product updates, go to either of the following:
  o Hewlett Packard Enterprise Support Center Get connected with updates page: www.hpe.com/support/e-updates
  o Software Depot website: www.hpe.com/support/softwaredepot
- To view and update your entitlements, and to link your contracts, Care Packs, and warranties with your profile, go to the Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page: www.hpe.com/support/AccessToSupportMaterials

⚠️ IMPORTANT:
Access to some updates might require product entitlement when accessed through the Hewlett Packard Enterprise Support Center. You must have an HP Passport set up with relevant entitlements.
Websites

<table>
<thead>
<tr>
<th>Website</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking websites</td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard Enterprise Networking Information Library</td>
<td><a href="http://www.hpe.com/networking/resourcefinder">www.hpe.com/networking/resourcefinder</a></td>
</tr>
<tr>
<td>Hewlett Packard Enterprise Networking website</td>
<td><a href="http://www.hpe.com/info/networking">www.hpe.com/info/networking</a></td>
</tr>
<tr>
<td>Hewlett Packard Enterprise Networking My Support</td>
<td><a href="http://www.hpe.com/networking/support">www.hpe.com/networking/support</a></td>
</tr>
<tr>
<td>General websites</td>
<td></td>
</tr>
<tr>
<td>Hewlett Packard Enterprise Information Library</td>
<td><a href="http://www.hpe.com/info/enterprise/docs">www.hpe.com/info/enterprise/docs</a></td>
</tr>
<tr>
<td>Hewlett Packard Enterprise Support Center</td>
<td><a href="http://www.hpe.com/support/hpesc">www.hpe.com/support/hpesc</a></td>
</tr>
<tr>
<td>Contact Hewlett Packard Enterprise Worldwide</td>
<td><a href="http://www.hpe.com/assistance">www.hpe.com/assistance</a></td>
</tr>
<tr>
<td>Subscription Service/Support Alerts</td>
<td><a href="http://www.hpe.com/support/e-updates">www.hpe.com/support/e-updates</a></td>
</tr>
<tr>
<td>Software Depot</td>
<td><a href="http://www.hpe.com/support/softwaredepot">www.hpe.com/support/softwaredepot</a></td>
</tr>
<tr>
<td>Customer Self Repair (not applicable to all devices)</td>
<td><a href="http://www.hpe.com/support/selfrepair">www.hpe.com/support/selfrepair</a></td>
</tr>
<tr>
<td>Insight Remote Support (not applicable to all devices)</td>
<td><a href="http://www.hpe.com/info/insightremotesupport/docs">www.hpe.com/info/insightremotesupport/docs</a></td>
</tr>
</tbody>
</table>

Customer self repair

Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:
www.hpe.com/support/selfrepair

Remote support

Remote support is available with supported devices as part of your warranty, Care Pack Service, or contractual support agreement. It provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett Packard Enterprise, which will initiate a fast and accurate resolution based on your product’s service level. Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

For more information and device support details, go to the following website:
www.hpe.com/info/insightremotesupport/docs

Documentation feedback

Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve the documentation, send any errors, suggestions, or comments to Documentation Feedback (docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition, and publication date located on the front cover of the document. For online help content, include the product name, product version, help edition, and publication date located on the legal notices page.